Chapter 5 - Overview of Performance Monitoring
Monitoring performance is a necessary part of preventive maintenance for your computer system. Through monitoring, you obtain performance data that is useful in diagnosing system problems and in planning for the growth in demand for system resources.
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
For more information about diagnosing system problems, see “Troubleshooting Strategies” in this book.

For more information about tools for monitoring performance, see Microsoft® Windows® 2000 Resource Kit Tools Help. 
Performance Monitoring Concepts
Regular performance monitoring ensures that you always have up-to-date information about how your computer is operating. When you have performance data for your system over a range of activities and loads, you can define a baseline—a range of measurements that represent acceptable performance under typical operating conditions. This baseline provides a reference point that makes it easier to spot problems when they occur. In addition, when you are troubleshooting system problems, performance data gives you information about the behavior of system resources at the time the problem occurs, which is useful in pinpointing the cause. Finally, monitoring system performance provides you with data to project future growth and to plan for how changes in your system configurations might affect future operation. Figure 5.1 shows the sequence for monitoring different system resources.
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Figure 5.1   Overall Monitoring Sequence
The following sections describe the scope and type of performance data collected, the design of the performance data architecture, and methods of data collection used by the performance tools.
Scope of Performance Data
In general, performance monitoring concentrates on how the operating system and any applications or services that are instrumented for performance-data collection use the resources of the system, such as the disks, memory, processors, and network components. Throughput, queue, and response time are terms that describe resource usage.
Throughput Defined
Throughput is a measure of the work done in a unit of time, typically evaluated from the server side in a client/server environment. Throughput tends to increase as the load increases up to a peak level. It then begins to fall, and a queue might develop. Throughput in an end-to-end system, such as client/server, depends on how each component performs. The slowest point in the system sets the throughput rate for the system as a whole. Often this slow point is referred to as a bottleneck. Performance monitoring tells you where bottlenecks occur in your system. The resource that shows the highest use is often the bottleneck, but not always—it can also mean a resource is successfully handling a lot of activity. As long as no queues develop, there is no bottleneck. Microsoft® Windows® 2000 reports throughput data on resources such as disks and network components.
Queue Defined
A queue can form under a few different circumstances. For example, a queue can develop when requests come in for service by the resource at a faster rate than the resource’s throughput, or if requests demand differing, particularly longer, amounts of time from the resource. A queue can also form if requests occur at random intervals—for example, in large batches for a time and then none at all. When a queue becomes long, work is not being handled efficiently, and you might experience delays in response time. Windows 2000 reports queue development on disks, processors, and server work queues, tracking server message block (SMB) calls of the Server service.
Response Time Defined
Response time is the measure of time required to do work from start to finish. In a client/server environment, you typically measure response time on the client side. Response time generally increases as the load increases. You can measure response time by dividing the queue length for the resource over the resource throughput. As an alternative, the new trace log feature in the Windows 2000 performance tools allows you to track units of work from start to finish in order to determine response times.
The following sections describe how performance monitoring tools enable users to collect data about the throughput, queue formation, and response time of different system resources.
Data Collection Architecture
Windows 2000 collects data about system resources, such as disks, memory, processors, and network components. In addition, applications and services that you might be running on your system can also perform data collection. By default, the operating system obtains performance data for system resources using the registry.
When you use performance tools to access registry functions for performance data, the system collects the data from the appropriate system object managers, such as the Memory Manager, the input/output (I/O) subsystem, and so forth.
As an option, Windows 2000 supports collecting data using the Windows Management Infrastructure (WMI) interface by means of the following command syntax typed at the Windows command prompt:
perfmon / WMI
In addition to several of the system performance counter DLLs, the operating system installs managed object files (MOFs) for data collection using WMI instead of the registry. These files reside in System32\Wbem\Mof. The Windows Management service must be running on the monitoring and monitored computer (if different) in order to obtain data using WMI.
Windows 2000 defines the performance data it collects in terms of objects, counters, and instances. Think of a performance object as any resource, application, or service that you can measure. The following sections describe these entities in more detail.
Performance Objects
By default, Windows 2000 installs numerous performance objects corresponding to hardware or other resources in the system. The following table shows the default performance objects installed by the operating system on a Microsoft® Windows® 2000 Professional installation. 
Table 5.1   Windows 2000 Performance Objects
Object name
Description
ACS/RSVP Service
Reports activity of the Quality of Service (QoS) Admission Control Service used to manage the priority use of network resources (bandwidth) at the subnet level.
Browser
Reports activity of the Browser service in Microsoft® Windows® 2000 Server that lists computers sharing resources in a  domain and other domain and workgroup names across the wide area network (WAN). Windows 2000 provides the Browser service for backward compatibility with clients that are running Microsoft® Windows® 95, Microsoft® Windows® 98, Microsoft® Windows® 3.x, and Microsoft® Windows NT®.
Cache
Reports activity for the file system cache, an area of physical memory that holds recently used data.
Distributed Transaction Coordinator
Reports statistics about activity of the Microsoft Distributed Transaction Coordinator, a part of Component Services (formerly known as Transaction Server) used to coordinate two-phase transactions by Message Queuing.
HTTP Indexing Service
Reports statistics regarding queries run by the Indexing service, a service that builds and maintains catalogs of the contents of local and remote disk drives to support powerful document-search capabilities.
IAS Accounting Clients
Reports activity of the Internet Authentication Service (IAS) as it centrally manages remote client accounting (usage). 
IAS Accounting Servers
Reports activity of the Internet Authentication Service (IAS) as it centrally manages remote server accounting (usage). 
IAS Authentication Clients
Reports activity of the Internet Authentication Service (IAS) as it centrally manages remote client authentication.
IAS Authentication Servers
Reports activity of the Internet Authentication Service (IAS) as it centrally manages remote server authentication.
ICMP
Reports the rates at which Internet Control Message Protocol (ICMP) messages are sent and received by using the ICMP protocol, which provides error correction and other packet information.
Indexing Service
Reports statistics pertaining to the creation of indexes and the merging of indexes by the Indexing service. Indexing service indexes documents and document properties on your disks and stores the information in a catalog. You can use Indexing service to search for documents, either with the Search command on the Start menu or with a Web browser.
Indexing Service Filter
Reports filtering activity of the Indexing service. Indexing service indexes documents and document properties on your disks and stores the information in a catalog. You can use Indexing service to search for documents, either with the Search command on the Start menu or with a Web browser.
IP
Reports activity at the Internet Protocol (IP) layer of Transmission Control Protocol/Internet Protocol (TCP/IP).
Job Object
Reports the accounting and processor usage data collected by each active, named job object.
Job Object Details
Reports detailed performance information about the active processes that make up a job object.
Logical Disk
Reports activity and usage of disk partitions and volumes.Use diskperf -y to enable disk counters and diskperf -n to disable them. To specify the type of counters you want to activate, include d for physical disk drives and v for logical disk drives or storage volumes. When the operating system starts up, it automatically sets the diskperf command with the -yd switch to activate physical disk counters. Type diskperf -yv to activate logical disk counters. For more information about using the diskperf command, type diskperf -? at the command prompt.
Memory
Reports usage of random access memory (RAM) used to store code and data.
NBT Connection
Reports the rate at which bytes are sent and received over connections that use the NetBT protocol, which provides NetBIOS support for the TCP/IP protocol between the local computer and a remote computer.
Network Interface
Reports rates at which bytes and packets are sent and received over a TCP/IP connection by means of the network adapters. Typically the first instance of the Network Interface object (Instance 1) that you see in System Monitor represents the loopback address; however, sometimes the loopback address does not appear. The loopback address is a local path through the protocol driver and the network adapter. All other instances represent installed network adapters (WAN interfaces, remote access modems, and so forth).
Objects
Reports data about system software objects, such as events, and so on.
Paging File
Reports usage of the paging file, used to back up virtual memory allocations.
Physical Disk
Reports usage of hard disks and redundant array of independent disks (RAID) devices.
Print Queue
Reports statistics for print jobs in the queue of the print server. New for Windows 2000.
Process
Reports activity of the process, which is a software object that represents a running program.
Processor
Reports activity of the processor (also called the CPU), the part of your computer hardware that carries out program instructions.
Redirector
Reports activity for the Redirector file system, which diverts file requests to network servers.
Server
Reports activity for the Server file system, which responds to file requests from network clients.
Server Work Queues
Reports the length of queues and objects in the queues for the Server service.
System
Reports statistics for systemwide counters that track file operations, processor time, and so on.
TCP
Reports the rates at which TCP segments are sent and received using the Transmission Control Protocol (TCP).
Telephony
Reports activity for telephony devices and connections.
Thread
Reports activity for a thread (the part of a process that uses the processor).
UDP
Reports the rates at which User Datagram Protocol (UDP) datagrams are sent and received using UDP.
If you are running Windows 2000 Server, Setup automatically installs the Active Server Pages, FTP Service, Internet Information Services Global, and Web Service objects for use with Internet Information Service. In addition, Windows 2000 Server Setup installs the SMTP Server and SMTP NTFS Store Driver objects. Depending on the services you have configured, your system might provide several additional objects, such as the NTDS object, which reports activity of the Active Directory™ directory service, and the DNS object, which reports performance statistics for the Domain Name System (DNS) service. For detailed information about these and other performance objects, see the Windows 2000 Performance Counters Reference on the Microsoft® Windows® 2000 Resource Kit companion CD.
For information about writing applications that install performance objects that can be integrated with the performance tools, see the Software Development Kit (SDK) documentation in the MSDN™ Library at http://windows.microsoft.com/windows2000/reskit/webresources.
Performance Counters and Instances
Each object has counters that are used to measure various aspects of performance, such as transfer rates for disks or the amount of processor time consumed for processors. Each object has at least one instance, which is a unique copy of a particular object type, though not all object types support multiple instances. This chapter and the following chapters describe objects, counters, and instances using the following syntax:
\\Computer_name\Object(ParentInstance/ObjectInstance#InstanceIndex)\Counter
The Computer_name portion is optional; if you do not include a computer name, the default is the local computer.
Note that the syntax includes a parent instance, object instance, and an instance index. This applies, for example, if the object has multiple instances and these instances might be identifiable by name or number, as defined by the counter developer. (Typically, internal system counters use numeric instance indexes.)
For example, if you are monitoring threads of the Microsoft Windows Explorer process, track the Windows Explorer instance of the Thread object (Windows Explorer would be the parent instance), and then each thread running Windows Explorer (these threads are child instances). The instance index allows you to track these child instances. The instance index for the thread you want might be 0, 1, and so on, for each thread, preceded by the number sign (#). The operating system configures System Monitor properties to display duplicate instances by default. Instance index 0 is hidden; numbering of additional instances starts with 1. You cannot monitor multiple instances of the same process unless you display instance indexes.
An instance called _Total is available on most objects, and represents a sum of the values for all instances of the object for a specific counter.
Data Collection and Reporting
Depending on the tools used, you can configure data collection to occur almost immediately or according to a predefined schedule. Performance data reported is sampled, meaning that data is collected periodically rather than traced, whereby data is obtained as events occur. This collection method has the advantage of keeping overhead low, but it might occasionally overestimate or underestimate values when activity falls outside the sampling interval.
If you want more precise performance data, use event tracing, a new capability in Windows 2000. Event tracing can measure activity as it happens, eliminating the inaccuracies of sampling and making it possible to correlate resource usage such as page faults, disk input/output (I/O), and processor time with workload that can include threads, processes, or transactions. This capability supplements counter-based monitoring methods. You can configure trace logs for providers you have or for the built-in system provider that runs traces for the Windows kernel provider using trace logs in Performance Logs and Alerts. Because running trace logs of page faults and file I/O data incurs some performance overhead, log this data only for brief periods. Note that an additional program is required to parse the log output into readable form. Developers can create such a tool using APIs provided in the Platform Software Development Kit. 
For information about writing a trace provider, see the Platform Software Development Kit (SDK) documentation in the MSDN Library at http://windows.microsoft.com/windows2000/reskit/webresources.
Depending on how a counter is defined, its values might be reported in one of the following ways:

Instantaneous counters, which might have names containing the word “current,” display the most recent measurement. Be aware that instantaneous counters might not provide meaningful data unless you have a steady workload.

Averaging counters, which typically have names that include “per second” or “percent,” measure a value over time and display the average of the last two measurements over the period between samples. (Because counters are never cleared, this is actually an average of the difference between the measurements.) When you start these counters, you must wait for the second measurement to be taken before any values are displayed. For example, Memory\Pages/sec shows the number of pages read over the sample interval, divided by the number of seconds in the interval.

For averaging counters, the sampling method can result in a slight delay in displaying values as data is collected and computed. In addition, after a single large value is reported, causing spikes in a performance graph, averaging counter values can be artificially high for a while until the average starts to reflect more recent steady-state activity.
Windows 2000 supports other types of counters, such as percentage, difference, and text. Difference counters display the change in value between the last two measurements. By default, counters that display their values as percentages cannot exceed 100 percent.
For information about the preceding generic counter types and their specific subtypes, see the Windows 2000 Performance Counter Reference (Counters.chm) on the Windows 2000 Resource Kit companion CD.
Monitoring Tools
The primary monitoring tools in Windows 2000 are the Performance console and Task Manager. Task Manager offers an immediate overview of system activity and performance, and the Performance console provides detailed information that can be used for troubleshooting and bottleneck analysis. The Performance console hosts two tools: System Monitor, and Performance Logs and Alerts. The chapters in this part of the Server Operations Guide concentrate on using the Performance console. The following sections describe the utilities that are installed with the operating system.
You can start the Performance console from the Administrative Tools menu. To use the Administrative Tools menu in Windows 2000 Professional:
Add the Administrative Tools menu to the Programs menu.
Or, use the Administrative Tools menu in Control Panel
Administrative Tools are provided on the Start menu by default in Windows 2000 Server.
To add the Administrative Tools menu to the Programs menu on a computer running Windows 2000 Professional
 1.
On the Start menu, point to Settings, and then click Taskbar & Start Menu.
 2.
Click the Start Menu Options tab. Under Start Menu Settings, select the Display Administrative Tools check box and then click OK.
 3.
Click the Start button again, point to Programs, and then click Administrative Tools.
To use the Administrative Tools menu in Control Panel
 1.
Double-click My Computer on the Windows 2000 desktop.
 2.
Under My Computer, double-click Control Panel.
 3.
In Control Panel, double-click Administrative Tools.
System Monitor
System Monitor in Windows 2000 extends the functionality provided by Performance Monitor, which shipped in Microsoft® Windows® NT versions 4.0 and Windows 3.51. Features of System Monitor include the following:

The graph display is much more flexible and configurable. You can modify many attributes of the display, including changing font and color, adding borders, and so on.

Counter configuration is simplified. You can now copy counter paths and settings from the System Monitor display to the Clipboard and paste counter paths from Web pages or other sources into the System Monitor display.

Graphs can be printed when performance displays are saved as HTML files using the Save As command on the shortcut menu. In addition, you can save reports as tab-separated files (for use with Microsoft Excel) by means of the Save As command. To use the shortcut menu, right-click the details pane of System Monitor.

System Monitor is portable. Because System Monitor is hosted in the Microsoft Management Console (MMC), you can save a console file containing a group of counters that you want to monitor—you can install it on any other computer and be able to monitor the same types of data on that computer. This is useful in monitoring other systems that you administer.

The functionality of System Monitor chart, histogram, and report views is provided by an ActiveX® control (Sysmon.ocx). This design gives a user the flexibility of including the control in an HTML page (PerfManager on the Windows 2000 Resource Kit companion CD is an example) or of programming the control into a Microsoft® Office or Microsoft® Visual Basic® application, as described in “Integrating the System Monitor Control into Office and Other Applications” later in this chapter. In most cases, you work with the control’s functionality in the form it is presented in Perfmon.msc, the Microsoft Management Console component that hosts the performance tools.
For information about logging and alert capabilities of the Performance console, see “Performance Logs and Alerts” later in this chapter. Windows NT 4.0 Performance Monitor is provided under the name Perfmon4.exe on the Windows 2000 Resource Kit companion CD. Typing perfmon.exe at the command prompt causes the system to launch System Monitor, not Performance Monitor.
Starting System Monitor
If you are running Windows 2000 Professional, you can start the Performance console as follows:

On the Administrative Tools menu, click Performance.

Or, on the Start menu, click Run, type perfmon.msc, and then click OK.

Or, type perfmon.msc at the Windows command prompt.
When you start the Performance console, a blank System Monitor graph appears. Performance Logs and Alerts appears beneath System Monitor in the console tree, as shown in Figure 5.2.
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Figure 5.2   Performance Console
The following section describes the user interface for System Monitor and provides tips on how to use it.
Working with System Monitor
With System Monitor you can create graphs, bar charts (histograms), and text reports of performance counter data. System Monitor is designed for short-term viewing of data, troubleshooting, and diagnosis.
The System Monitor display consists of the following elements:

An optional toolbar with capabilities such as copying and pasting counters, clearing counters, adding counters, and so on. The toolbar buttons provide the quickest way of configuring the monitoring display, but you can also use a shortcut menu to add counters and configure properties.

The area where counter values are displayed. You can vary the line style, width, and color of these lines. You can also change the color of the window and of the chart within the window.

A legend showing the selected counters and associated data such as the computer name, parent object, and instances.

A value bar, where you see the last, minimum, maximum, and average values for the counter that is currently selected. The value bar also shows a Duration value that indicates the total elapsed time displayed in the graph (based on the update interval).

A timer bar that moves across the graph indicates the passing of each update interval. Regardless of the update interval, the view shows up to 100 samples. System Monitor compresses log data as necessary to fit it in the display. For example, if there are 1,000 samples, the display might show every tenth sample.
You can configure System Monitor using either the toolbar or a shortcut menu. Using the shortcut menu offers more control and flexibility in configuring the display. The following sections describe these different configuration methods. To see procedures and a brief overview of System Monitor, click Help on the System Monitor toolbar.
Using the Toolbar
The toolbar is displayed by default. Using the toolbar, you can configure the following options:

Type of display. Use the View Chart, View Histogram, or View Report button.

Figure 5.3 shows the different display options.
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Figure 5.3   Display Type Options for System Monitor

Histograms and reports are useful for simplifying graphs with multiple counters. However, they display only a single value, so they are recommended only when you are charting current activity and watching the graphs as they change. When you are reviewing data logged over time, line graphs are much more informative so that trends can be identified.

Data source. Click the View Current Activity button for real-time data or the View Log File Data button for data from either a completed or a currently running log.

Counters. Use the Add or Delete buttons as needed. You can also use the New Counter Set button to reset the display and select new counters. Clicking the Add button displays the Add Counters dialog box, as shown in Figure 5.4. You can also press the DEL key to delete a counter that is selected in the legend.
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Figure 5.4   Add Counters Dialog Box

Data updates. Click Clear Display to clear the displayed data and obtain a fresh data sample for existing counters. To suspend data collection, click Freeze Display. Use the Update Data button to resume collection.

Highlighting chart or histogram data. To accentuate the line or bar for a selected counter with white (default) or black (for light backgrounds), click Highlight on the toolbar.

Importing or exporting counter settings. To save the displayed configuration to the Clipboard for insertion into a Web page, click Copy Properties. To import counter settings from the Clipboard into the current System Monitor display, click Paste Counter List.

Configuring other System Monitor properties. To access colors, fonts, or other settings that have no corresponding button on the toolbar, click Properties.
Using the Shortcut Menu
When you right-click the System Monitor display, a shortcut menu appears with the following options:

Add Counters. Use this option in the same way you use the Add button in the toolbar.

Save As. Use this if you want to save the current display configuration under a new name. If you click Save on the Console menu, the current settings are stored, overwriting the blank version of Perfmon.msc installed by Windows 2000 Setup and altering the default appearance of the tool.

Properties. Click this button to access the five properties tabs that provide options for controlling all aspects of System Monitor data collection and display. The General properties tab appears by default, as shown in Figure 5.5.
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Figure 5.5   General Tab

Many properties can be configured from the toolbar, but some are only configurable using System Monitor Properties. The following table lists property tabs alphabetically by name, along with the attributes they control.
Table 5.2   System Monitor Properties
Use this tab
To add or change this
Colors
Background color of results pane surrounding the chart area, color of chart data-display area.You can choose each color from a palette (in the Property Name list box) or you can base the colors on system colors (screen elements) defined using the Display icon in Control Panel. When using the palette, note the following:   BackColorCtl refers to the area surrounding the chart.   BackColor refers to the chart data-display area.   ForeColor refers to the color of the text in the display and legend.

Grid color, timer bar color.
Data
Color, width, style, or chart line.Notice that defining a nondefault line width limits the line styles that are available. Styles can be selected only when you are using the default line width.

Scale of counter data values.Counter values can be scaled exponentially from .0000001 to 1000000. You might want to adjust the counter scale settings to enhance the visibility of counter data in the chart. Changing the scale does not affect the statistics displayed in the value bar.

Objects, counters, and instances.
Fonts
Font type, size, and style.
General
View type: chart, histogram, or report.

Update frequency and manual or periodic sampling.

Histogram or report value type (choose between minimum, maximum, average values for the one displayed in a report view).Using report value types other than Current when monitoring real-time data incurs substantial overhead because of the need to make calculations across all samples for each value displayed.

Display of counter legend.

Display of last, minimum, and maximum values for a selected counter (the value bar).

Border style, appearance of the entire control. You can include or omit a border, or configure three-dimensional or flat effects for the window. 

Display of toolbar.

Display of instance indexes (for monitoring multiple instances of a counter).The first instance (instance number 0) displays no index; System Monitor numbers subsequent instances starting with 1.
Graph
Title of graph.

Label on value axis, vertical or horizontal grid lines, and upper and lower limits of graph axes.
Source 
Source of data displayed: current data input to the graph, current or archived data input from a log.

Time range for a log and view time range.
Getting the Most from System Monitor
Windows 2000 Server online Help for System Monitor explains how to perform common tasks. The following list supplements the information provided in online Help to enable you to use System Monitor more effectively.

Print data. You can print performance data in several ways:

Copy the current view to the Clipboard (by pressing ALT+PRINT SCREEN), start a paint program, paste in the image from the Clipboard, and then print it.

Add the System Monitor control to a Microsoft Office application such as Microsoft® Word or Microsoft® Excel, configure it to display data, and then print from that program. For information about this process, see “Integrating the System Monitor Control into Office and Other Applications” later in this chapter.

Save the System Monitor control as an HTML file by right-clicking the details pane of System Monitor and typing a file name for the HTML file to be created. You can then open the HTML file and print it from Microsoft® Internet Explorer or another program.

Import a log file in comma-separated (.csv) or tab-separated (.tsv) format into an Excel spreadsheet and print from that application. 

Learn about individual counters. When adding counters, if you click Explain in the Add Counters dialog box for System Monitor or Performance Logs and Alerts, you can view counter descriptions. 

Vary the data displayed in a report. By default, reports display only one value for each counter. This is current data if the data source is real-time activity, or averaged data if the source is a log. However, using the General properties tab, you can configure the report display to show different values, such as the maximum, minimum, and so on. Notice that monitoring the nondefault value for a report can increase performance-monitoring overhead.

Arrange items in the legend. To sort entries in ascending or descending order for that category, click Object, Counter, Instance, or Computer in the counter legend. For example, to sort all counters by name, click Counter.

Select a group of counters or counter instances to monitor.

To select all counters or instances, click All counters or All instances. 

To select specific counters or instances, click Select counters from the list or Select instances from the list.

To monitor a group of consecutive counters or instances in a list box, hold down the SHIFT key and scroll down through the items in the list box.

To select multiple, nonconsecutive counters or instances, select the item and press CTRL.

Important   Monitoring large numbers of counters can incur a high amount of overhead, even to the point of making the system unresponsive to keyboard or mouse input. To reduce this burden, display data in report view when collecting from large numbers of counters or direct data to a binary log, and view the data in System Monitor as it is being written to the log.

Simplify detailed graphs. You can maintain two separate instances of System Monitor if you want to monitor a large number of counters while keeping each graph relatively simple and uncluttered. It is also a good way to compare data from different sources.

Track totals for all instances of a counter. Instead of monitoring individual instances for a selected counter, you can instead use the _Total instance, which sums all instances’ values and reports them in System Monitor.

Pinpoint a specific counter from lines in a graph. To match a line in a graph with the counter for which it is charting values, double-click a position in the line. If chart lines are close together, try to find a point in the graph where they diverge.

Accentuate a specific counter’s data. To draw attention to a particular counter’s data, use the highlighting feature. To do so, press CTRL+H or click Highlight on the toolbar. For the counter selected, a thick line replaces the colored chart line. For white or light-colored backgrounds (defined by the BackColor property), this line is black; for other backgrounds, this line is white.

View data from a running log. If you are working with a log file that is currently collecting data, you need to click the Select Time Range button and keep moving the Time Range bar to the right to update the display with new samples.

Use Windows NT 4.0 settings files. You can display legacy alert, report, chart, and log settings files in System Monitor by using the following command at the command prompt:

perfmon.exe settings_file_name

When you open one of these settings files, the system temporarily converts the file for use with System Monitor but discards the converted version after the console starts. If you want to save the settings file for permanent use with System Monitor, type the following command:

perfmon.exe /HTMLFILE:new_file_name settings_file_name
Performance Logs and Alerts
Performance Logs and Alerts, a service in Windows 2000, improves the logging and alert capabilities that were provided in Windows NT 4.0. Logging is used for detailed analysis and record-keeping purposes. Retaining and analyzing log data collected over a period of several months can be helpful for capacity and upgrade planning.
Windows 2000 provides two types of performance-related logs—counter logs and trace logs—and an alerting function. The following list describes these new or enhanced tools:

Performance Logs and Alerts replaces Performance Data Log in the Windows NT Server 4.0 Resource Kit. As a result, data collection occurs regardless of whether any user is logged on to the computer.

In Windows 2000, counter logs record sampled data about hardware resources and system services based on performance objects and counters in the same manner as System Monitor. When a counter log has been started, the Performance Logs and Alerts service obtains data from the system when the update interval has elapsed. 

Trace logs collect event traces that measure performance statistics associated with events such as disk and file I/O, page faults, or thread activity. When the event occurs, a data provider designed to track these events sends the data to the Performance Logs and Alerts service. The data is measured from start to finish, rather than sampled in the manner of System Monitor. The built-in Windows 2000 kernel trace data provider supports tracing system data; if other data providers are available, developers can configure logs with those providers as appropriate. A parsing tool is required to interpret the trace log output. Developers can create such a tool using APIs provided in the Platform Software Development Kit.

With the alerting function, you can define a counter value that will trigger actions such as sending a network message, running a program, or starting a log. Alerts are useful if you are not actively monitoring a particular counter threshold value but want to be notified when it exceeds or falls below a specified value so that you can investigate and determine the cause of the change. You might want to set alerts based on established performance baseline values for your system. For information about establishing a baseline, see “Starting Your Monitoring Routine” later in this chapter.

Viewing logged data is easier and more convenient. Counter logs can be viewed in System Monitor as they are collecting data as well as after data collection has stopped. Data in counter logs can be saved as comma-separated or tab-separated files that are easily viewed with Excel.

Logs can be circular—that is, recording data until they achieve a user-defined size limit and then starting over. Alternatively, linear logs collect data according to user-defined parameters such as: run for a specified length of time, stop when that parameter is met, and start a new log. A binary file format can also be defined for logging intermittent data (such as for a process that is not running when you start the log but that begins and ends during the logged interval).

You can save log settings to an HTML file or you can import settings from an HTML page to create new logs. When exported, the resulting HTML page hosts the System Monitor control, an ActiveX control that provides the performance monitoring user interface. If you open this page, you can dynamically observe, from a System Monitor view, the same counters you configured in the log. When imported, a new log or alert is created, based on the settings in the HTML page. This is a convenient way to insert the same settings into both a log and an alert, if appropriate.

Configuring logs and alerts is flexible and easy to manage. Users can manage multiple logging sessions from a single console window. For each log, users can start and stop logging either manually, on demand, or automatically, at scheduled times or based on the elapsed time or the current file size. Users can also specify automatic naming schemes and stipulate that a program be run when a log is stopped.
Starting Performance Logs and Alerts
In Windows 2000 Professional, the Performance Logs and Alerts component is available in the Performance console and in the Computer Management console. The following procedures describe how to open the component from these locations.
Note   This procedure assumes that you have added the Administrative Tools option to your Programs menu as described in “System Monitor” earlier in this chapter.
To start Performance Logs and Alerts from the Performance console
 1.
Click Start, point to Programs, and then click Administrative Tools.
 2.
Click Performance.
 3.
Double-click Performance Logs and Alerts to display the available tools.
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Figure 5.6   Performance Logs and Alerts Console Tree
Working with Logs and Alerts
To begin configuring logs and alerts, click the name of the tool to select it. If any logs or alerts have previously been defined, they will appear in the appropriate node of the details pane. A sample settings file for a counter log named System Overview is included with Windows 2000. You can use this file to see some basic system data such as memory, disk, and processor activity. For information about the types of data to monitor in your own configuration, see “Starting Your Monitoring Routine” later in this chapter.
Right-click in the details pane to create a new log or alert. You can do this in a new file or you can use settings from an existing HTML file as a template.
Note   You must have Full Control access to a subkey in the registry in order to create or modify a log configuration. (The subkey is HKEY_CURRENT_MACHINE\SYSTEM\CurrentControlSet\Services\SysmonLog\Log_Queries.) In general, administrators have this access by default. Administrators can grant access to users by using the Security menu in Regedt32.exe. To run the Performance Logs and Alerts service, you must have the right to start or otherwise configure services on the system. Administrators have this right by default and can grant it to users by using Group Policy. For information about starting and using Group Policy, see Windows 2000 Server Help.
You are prompted to name your log or alert and then to define properties. Figure 5.7 is an illustration of the General properties tab for a counter log.
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Figure 5.7   General Properties Tab for a Counter Log
If you are configuring a counter log or an alert, use the Add Counters dialog box to specify objects, counters, instances, and updating. If you are configuring a trace log, use the General property tab shown in Figure 5.8.
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Figure 5.8   General Properties Tab for Trace Log
Each tool offers some unique properties. The ability to configure scheduling is common to logs and alerts, but some options might not be available for all tools. Table 5.3 describes the options available in each tool and the property tab to use to configure it.
Table 5.3   Summary of Log and Alert Properties
For this feature
Use this tab
To configure these settings
Notes
Alerts
General
Counters, sample interval, alert threshold, and alert comment



Action
Actions to take when an event occurs
Examples of actions for an alert include running a program, sending a message, starting a counter log, and updating the event log.

Schedule
Start and stop parameters for alerts
Automated restart is not available if you configure the alert to stop manually.You might need to update the Performance Logs and Alerts service properties if you opt to run a program that displays to the screen after the system triggers an alert. Use Services under Services and Applications in Computer Management for this purpose. 
Counter Logs
General
Counter log counters and sample interval



Log Files
File type, file size limits, path and name, and automatic naming parameters 
Counter logs can be defined as comma-separated or tab-separated text files, or as binary linear or circular files.
Counter Logs
Schedule
Manual or automated start and stop methods and schedule
Counter logs can be defined as comma-separated or tab-separated text files, or as binary linear or circular files.You can specify that the log stop when the log file is full.You cannot configure the service to automatically restart or to run a program if a log is configured to stop manually.You cannot configure a log to stop when full if the file is configured on the Log Files tab to grow to a maximum size limit.
Trace Logs
General
Trace log providers and events to log
You cannot configure the service to automatically restart if a log is configured to stop manually.You can have only one system trace log running at a time. You cannot enable multiple providers simultaneously.To obtain disk input/output data from the system provider, you must also select File details.

Log Files
Trace log comment, file type, path and name, and automatic naming parameters
Only two types of trace logs are available: circular and sequential.

Schedule
Start and stop parameters for a trace log
You cannot configure the service to automatically restart or to run a program if a log is configured to stop manually.

Advanced
Trace log buffer size, limits, and transfer  interval (periodic flushing)


To start or stop a log or alert, right-click the name in the Performance Logs and Alerts window, point to All Tasks, and then click Start or Stop.
Getting the Most from Performance Logs and Alerts
Windows 2000 Server online Help for Performance Logs and Alerts describes performing the most common tasks with logs and alerts. The following list provides some additional hints about using the tools effectively:

Export log data to a spreadsheet for reporting purposes. Importing log data into a spreadsheet program such as Excel offers benefits, such as easy sorting and filtering of data. To format the data for easy export, configure the log file type as Text File-CSV or Text File-TSV on the Log Files properties tab.

Record transient data in a log. Not all counter log file formats can accommodate data that is not persistent throughout the duration of the log. If you want to record intermittent data such as a process that starts after you start the log, select the binary linear or circular file format on the Log Files tab.

Limit log file size to avoid disk-space problems. If you choose automated counter logging with no scheduled stop time, the file will grow to the maximum size allowed based on available space on your disk up to 2GB (the largest log file that System Monitor can read). Trace logs have no file-size limit. When setting this option, take into consideration your available disk space and any disk quotas that are in place. Change the file path from the default (the Perflogs folder on the local computer) to a location with adequate space if appropriate. An error might occur if your disk runs out of disk space due to logging.

Name files for easy identification. Use File name and End file names with on the Files properties tab to make it easy to find specific log files. For example, if you set up periodic logging, such as a log for every day of the week, you can develop different naming schemes with the base name being the computer where the log was run, or the type of data being logged, followed by the date as the suffix. For example, you could have a scheme that generates a file named ServerRed1_050212.blg, meaning it was created on a computer named ServerRed1 at noon, assuming the End file name with entry was set at mmddhh.

Determine what trace data providers are available for trace logging. On the General properties tab, click Provider Status to see all data providers that have been installed. To see only enabled (running) data providers, click the Show only enabled providers check box in the Provider Status dialog box. For more information about WMI data providers, see the WMI SDK documentation in the MSDN Library at http://windows.microsoft.com/windows2000/reskit/webresources. You can only have one instance of each provider running at the same time.
Task Manager
Task Manager provides information about applications currently running on your system, the processes and memory usage or other data about those processes, and statistics about memory and processor performance.
Comparison with System Monitor
Although useful as a quick reference to system operation and performance, Task Manager lacks the logging and alert capabilities of the Performance console. In addition, although the data displayed by Task Manager comes from the same source as some performance counters, Task Manager does not have access to the breadth of information available from all installed counters. However, Task Manager provides capabilities not available with the Performance console, as described in Table 5.4. For information about these capabilities, see online Help for Task Manager and the chapters identified in Table 5.4.
Table 5.4   Other Chapters on Task Manager
Capability
Server Operations Guide chapter
Stop running processes.
“Analyzing Processor Activity”
Change the base priority of a process.
“Analyzing Processor Activity”
   Set affinity for a process to a particular processor (on multiprocessor systems).
“Measuring Multiprocessor System Activity”


Starting Task Manager
To start Task Manager, use any of these methods:

Press CTRL+SHIFT+ESC.

Right-click the taskbar, and then click Task Manager.

Press CTRL+ALT+DEL, and then click Task Manager.
You can also start Task Manager from the command prompt or the Run dialog box.
Working with Task Manager
Task Manager has three tabs: Applications, Processes, and Performance. While Task Manager is running, the status bar always displays the total number of processes, CPU use, and virtual memory use for the system. Note the following display possibilities:

All Task Manager columns can be resized.

Clicking a column sorts its entries in ascending or descending order.

Select Always on Top from the Options menu to keep the window in view as you switch between applications.

Press CTRL+TAB to toggle between tabs, or click the tab.
When Task Manager is running, an accurate miniature CPU usage gauge appears on the taskbar on the end opposite the Start button. When you place the mouse pointer over this icon, it displays the percentage of processor use in text format. The miniature gauge always matches the CPU Usage History chart on the Performance tab, as shown in Figure 5.9.
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Figure 5.9   Task Manager CPU Gauge Shown on the Taskbar
To make Task Manager the top window, double-click the gauge, or right-click the gauge and then select Task Manager from the menu that appears.
If you run Task Manager frequently and do not want to see its button on the taskbar, click Hide When Minimized on the Options menu. To open an instance of Task Manager when it is hidden, click the Task Manager CPU gauge on the taskbar.
You can control the rate at which Task Manager updates its counts by setting the Update Speed option on the View menu.

High. Updates every half-second.

Normal. Updates once per second.

Low. Updates every 4 seconds.

Paused. Does not update automatically. Press F5 to update.
This will reduce Task Manager overhead, but might cause you to miss some data. You can force an update at any time by clicking Refresh Now on the View menu or by pressing F5.
Monitoring Processes
In Task Manager, click the Processes tab to see a list of running processes and measures of their performance. The Task Manager process table includes all processes that run in their own address space, including all applications and system services.
To include those in the display, on the Options menu, click Show 16-bit Tasks. Figure 5.10 is an example of how Task Manager displays process information.
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Figure 5.10   Processes Tab in Task Manager
Note   System Monitor displays its values in bytes, whereas Task Manager displays its values in kilobytes, which are units of 1,024 bytes. When you compare System Monitor and Task Manager values, multiply System Monitor values by 1,024.
To add to or remove performance measures from the display for the processes listed, on the View menu, click Select Columns. Table 5.5 briefly describes the measures and their System Monitor counterparts, if any.
Table 5.5   Comparison of Process Data Supplied by Task Manager and System Monitor 
Task Manager process measure
Description
System Monitor process object counters 
Base Priority
The base priority of the process, which determines the order in which its threads are scheduled for the processor.The base priority is set by the process code, not the operating system. The operating system sets and changes the dynamic priorities of threads in the process within the range of the base.Use Task Manager to change the base priority of processes. For more information about changing priority to improve processor performance, see “Analyzing Processor Activity” in this book.
Priority Base
CPU Time
The total processor time, in seconds, used by the process since it was started.
None
CPU Usage
The percentage of time the threads of the process used the processor since the last update.
% Processor Time
GDI Objects
The number of Graphics Device Interface (GDI) objects currently used by a process. A GDI object is an object from the GDI library of application programming interfaces (APIs) for graphics output devices.
None
Handle Count
The number of object handles in the process’s object table.
Handle Count
I/O Other
The number of input/output operations generated by a process that are neither reads nor writes, including file, network, and device I/Os. An example of this type of operation would be a control function. I/O Others directed to CONSOLE (console input object) handles are not counted.
I/O Other Operations/secFor more information about monitoring I/O, see the following chapters in this book:“Examining and Tuning Disk Performance”“Monitoring Network Performance”
I/O Other Bytes
The number of bytes transferred in input/output operations generated by a process that are neither reads nor writes, including file, network, and device I/Os. An example of this type of operation would be a control function. I/O Other Bytes directed to CONSOLE (console input object) handles are not counted.
I/O Other Bytes/sec
I/O Read Bytes
The number of bytes read in input/output operations generated by a process, including file, network, and device I/Os. I/O Read Bytes directed to CONSOLE (console input object) handles are not counted.
I/O Read Bytes/sec
I/O Reads
The number of read input/output operations generated by a process, including file, network, and device I/Os. I/O Reads directed to CONSOLE (console input object) handles are not counted.
I/O Read Operations/sec
I/O Write Bytes
The number of bytes written in input/output operations generated by a process, including file, network, and device I/Os. I/O Write Bytes directed to CONSOLE (console input object) handles are not counted.
I/O Write Bytes/sec
I/O Writes
The number of write input/output operations generated by a process, including file, network, and device I/Os. I/O Writes directed to CONSOLE (console input object) handles are not counted.
I/O Write Operations/sec
Image Name
Name of the process.
The process name in the Instances box
Memory Usage
The amount of main memory, in kilobytes, used by the process.
Working Set
Memory Usage Delta
The change in memory use, in kilobytes, since the last update. Unlike System Monitor, Task Manager displays negative values.
None
Nonpaged Pool
The amount of memory, in kilobytes, used by a process. Operating system memory that is never paged to disk. Paging is the moving of infrequently used parts of a program’s working memory from RAM to another storage medium, usually the hard disk.
Pool Nonpaged Bytes
Page Faults
The number of times that data had to be retrieved from disk for this process because it was not found in memory. This value is accumulated from the time the process is started.
NonePage faults/sec is the rate of page faults over time.
Page Faults Delta
The change in the number of page faults since the last update.
None
Paged Pool
The amount of system-allocated virtual memory, in kilobytes, used by a process. The paged pool is virtual memory available to be paged to disk. Paging is the moving of infrequently used parts of a program’s working memory from RAM to another storage medium, usually the hard disk. The paged pool includes all of user memory and a portion of system memory.
Pool Paged Bytes
Peak Memory Usage
The peak amount of physical memory resident in a process since it started.
None
PID (Process Identifier)
Numerical ID assigned to the process while it runs.
ID Process
Thread Count
The number of threads running in the process.
Thread Count
USER Objects
The number of USER objects currently being used by a process. A USER object is an object from Window Manager, which includes windows, menus, cursors, icons, hooks, accelerators, monitors, keyboard layouts, and other internal objects.
None
Virtual Memory Size
The amount of virtual memory, or address space, committed to a process.
Private Bytes
For more information about Task Manager and its use in monitoring processor and memory performance, see the following chapters in this book:

“Evaluating Memory and Cache Usage”

“Analyzing Processor Activity” 

“Measuring Multiprocessor System Activity”
Monitoring the System
To see a dynamic overview of system performance, including a graph and numeric display of processor and memory usage, click the Task Manager Performance tab, as shown in Figure 5.11.
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Figure 5.11   Task Manager Performance Tab
To graph the percentage of processor time in privileged or kernel mode, click Show Kernel Times on the View menu. This is a measure of the time that applications are using operating system services. The remaining time, known as user mode, is spent running threads within the application code.
Users of multiple-processor computers can click CPU History on the View menu and then graph the nonidle time of each processor in a single graph or in separate graphs.
The following table briefly describes the counts on the Performance tab and their System Monitor counterparts, if any.
Table 5.6   Comparison of System Data Provided by Task Manager and System Monitor
Task Manager counts
Description
System Monitor counters
CPU Usage
The percentage of time the processor is running a thread other than the Idle thread.
Processor\% Processor Time
MEM Usage
The amount of virtual memory used, in kilobytes.
Memory\Committed Bytes
Total Handles
The number of object handles in the tables of all processes.
Process(_Total)\Handle Count
Total Threads
The number of running threads, including one Idle thread per processor.
Process(_Total)\Thread Count
Total Processes
The number of active processes, including the Idle process.
Object\Processes is the same, but excludes the Idle process.
Physical Memory: Total
Amount of physical, random access memory, in kilobytes, installed in the computer.
None
Physical Memory: Available
Amount of physical memory available to processes, in kilobytes.It includes zeroed, free, and standby memory.
Memory\Available Bytes
Physical Memory: File Cache
Amount of physical memory, in kilobytes, released to the file cache on demand.
Memory\Cache Bytes
Commit Charge: Total
Size of virtual memory in use by all processes, in kilobytes.
Memory\Committed Bytes
Commit Charge: Limit
Amount of virtual memory, in kilobytes, that can be committed to all processes without enlarging the paging file.
Memory\Commit Limit
Commit Charge: Peak
The maximum amount of virtual memory, in kilobytes, used in the session.The commit peak can exceed the commit limit if virtual memory is expanded.
None
Kernel Memory: Total
Sum of paged and nonpaged memory, in kilobytes.
None(Sum of Pool Paged Bytes and Pool Nonpaged Bytes)
Kernel Memory: Paged
Size of the paged pool, in kilobytes, allocated to the operating system.
Memory\Pool Paged Bytes
Kernel Memory: Nonpaged
Size of the nonpaged pool, in kilobytes, allocated to the operating system.
Memory\Pool Nonpaged Bytes
Resource Kit Performance Tools
The Windows 2000 Resource Kit companion CD contains other performance-related tools, such as the following:

Ctrlist.exe. This prints counter descriptions to a file or to the screen.

Extctrlst.exe. This lists all counter DLLs that are running and provides the capability of disabling them. For more information about disabling counters, see “Troubleshooting Problems with Performance Tools” later in this chapter.

Perfmtr.exe. This command-line utility is useful for dynamically monitoring performance statistics relating to memory, processor, and I/O activity.

Showperf.exe. This program is useful for developers who want to see the counter type, index, and the contents of the Performance Data block so they can view and debug the counter’s raw data structure.

Typeperf.exe. This is a command-line utility for displaying performance information from individual performance counters.
For information about the utilities listed, see the Windows 2000 Resource Kit Tools Help. Programs used in specific bottleneck analysis contexts are described in the chapters to which they apply.
Starting Your Monitoring Routine
Setting up a monitoring routine consists of several steps, including setting up a basic monitoring configuration (sometimes called “overview” settings), testing the limits of acceptable performance under various conditions, and establishing a baseline. The following sections describe how to undertake these steps.
Your Minimum Monitoring Configuration
The minimum performance objects to monitor are those corresponding to the main hardware resources of your system: memory, processors, disks, and network components. Table 5.7 lists the appropriate counters and the categories of information they provide.
Table 5.7   Monitoring the Minimum Objects

Component
Performance aspect being monitored

Counters to monitor
Disk
Usage
LogicalDisk\% Free Space LogicalDisk\% Disk TimePhysicalDisk\Disk Reads/secPhysicalDisk\Disk Writes/secUse diskperf -y to enable disk counters and diskperf -n to disable them. To specify the type of counters you want to activate, include d for physical disk drives and v for logical disk drives or storage volumes. When the operating system starts up, it automatically sets the diskperf command with the -yd switch to activate physical disk counters. Type diskperf -yv to activate logical disk counters. For more information about using the diskperf command, type diskperf -? at the command prompt.The % Disk Time counter must be interpreted carefully. Because the _Total instance of this counter might not accurately reflect utilization on multiple-disk systems, it is important to use the % Idle Time counter as well. Note that these counters cannot display a value exceeding 100 percent.For more information about disk performance counters, see “Examining and Tuning Disk Performance” in this book.
Disk
Bottlenecks
LogicalDisk\Avg. Disk Queue Length PhysicalDisk\Avg. Disk Queue Length (all instances)
Memory
Usage
Memory\Available BytesMemory\Cache BytesYou can also use Memory\Committed Bytes and Memory\Commit Limit to detect problems with virtual memory.
Memory
Bottlenecks or leaks
Memory\Pages/sec Memory\Page Faults/secMemory\Pages Input/secMemory\Page Reads/secMemory\Transition Faults/secMemory\Pool Paged BytesMemory\Pool Nonpaged BytesAlthough not specifically Memory object counters, the following are also useful for memory analysis:Paging File\% Usage Object (all instances)Cache\Data Map Hits %Server\Pool Paged Bytes and Server\Pool Nonpaged Bytes
Network
Usage
Network Segment: % Net UtilizationNote that you need to install the Network Packet Protocol driver for Network Monitor in order to use this counter.
Network
Throughput
Protocol transmission counters (varies with networking protocol); for TCP/IP:Network Interface\Bytes total/secNetwork Interface\Packets/secServer\Bytes Total/sec or Server\Bytes Sent/sec and Server\Bytes Received/secYou might want to monitor other objects for network and server throughput, as described in “Monitoring Network Performance” in this book..
Processor
Usage
Processor\% Processor Time (all instances)

Bottlenecks
System\Processor Queue Length (all instances)Processor\Interrupts/secSystem\Context switches/sec
If you want to test the limits of your system as part of establishing a baseline, monitor the recommended counters during the following activities:

Adding base services

Adding connections

Running network applications

Opening a file

Printing a file

Copying or writing to a file

Accessing a database

Sending a message
Establishing the Baseline
After becoming familiar with System Monitor and the process of configuring graphs and logs, you are ready to incorporate monitoring into your daily routine of system administration. Routine monitoring over periods ranging from days to weeks to months allows you to establish a baseline for system performance.
A baseline is a measurement that is derived from the collection of data over an extended period during varying but typical types of workloads and user connections. The baseline is an indicator of how individual system resources or a group of resources are used during periods of normal activity.
When determining your baseline, it is very important to know the types of work being done and the days and times when the work is being done. That will help you to associate work with resource usage and to determine the reasonableness of performance during those intervals.
For example, if you find that performance diminishes somewhat for a brief period at a given time of day, and you find that at that time many users are logging on or off, it might be an acceptable slowdown. Similarly, if you find that performance is poor every evening at a certain time and you can tell that that time coincides with nightly backups when no users are logged on to the system, again that performance loss might be acceptable. But you can make that determination only when you know the degree of performance loss and its cause.
When you have built up data on performance over a period, with data reflecting periods of low, average, and peak usage, you can make a subjective determination of what constitutes acceptable performance for your system. That determination is your baseline. Use your baseline to detect when bottlenecks are developing or to watch for long-term changes in usage patterns that require you to increase capacity.
Analyzing Monitoring Results
The baseline you develop establishes the typical counter values you should expect to see when your system is performing satisfactorily. The following section provides guidelines to help you interpret the counter values and eliminate false or misleading data that might cause you to set your own target values inappropriately.
When you are collecting and evaluating data to establish a valid performance baseline, consider the following guidelines:

When monitoring processes of the same name, watch for unusually large values for one instance and not the other. This can occur because System Monitor sometimes misrepresents data for separate instances of processes of the same name by reporting the combined values of the instances as the value of a single instance. Tracking processes by process identifier can help you get around this problem. For information about monitoring processes, see “Analyzing Processor Activity” later in this book.

When you are monitoring several threads and one of them stops, the data for one thread might appear to be reported for another. This is because of the way threads are numbered. For example, you begin monitoring and have three threads, numbered 0, 1, and 2. If one of them stops, all remaining threads are resequenced. That means that the original thread 0 is now gone and the original thread 1 is renamed to 0. As a result, data for the stopped thread 0 could be reported along with data for the running thread 1 because old thread 1 is now old thread 0. To get around this problem, you can include the thread identifiers of the process’s threads in your log or display. Use the Thread\Thread ID counter for this purpose.

Do not give too much weight to occasional spikes in data. These might be due to startup of a process and are not an accurate reflection of counter values for that process over time. The effect of spikes can linger over time when using counters that average.

For monitoring over an extended period of time, use graphs instead of reports or histograms because these views only show last values and averages. As a result, they might not give an accurate picture of values if you are looking for spikes.

Unless you specifically want to include startup events in your baseline, exclude these events because the temporary high values tend to skew overall performance results.

Investigate zero values or missing data. These can impede your ability to establish a meaningful baseline. There are several possible explanations for this. For more information, see “Troubleshooting Problems with Performance Tools” later in this chapter.
Identifying Potential Bottlenecks
Deviations from your baseline provide the best indicator of performance problems. However, as a secondary reference, the following table describes recommended thresholds for object counters. Use this table to help you identify when a performance problem is developing on your system. If the values listed are consistently reported on your system, consult additional chapters in the Performance Monitoring section of this book for how to investigate and correct the problems causing these values.
Table 5.8   Recommended Thresholds for the Minimum Set of System Counters
Resource
Object\Counter
Suggested threshold
Comments
Disk
LogicalDisk\% Free Space
15 percent
None
Disk
LogicalDisk\% Disk Time
90 percent
None
Disk
PhysicalDisk\ Disk Reads/sec, PhysicalDisk\ Disk Writes/sec
Depends on manufacturer’s specifications
Check the specified transfer rate for your disks to verify that this rate does not exceed the specifications. In general, Ultra Wide SCSI disks can handle 50 to 70 I/O operations per second.
Disk
PhysicalDisk\ Current Disk Queue Length
Number of spindles plus 2
This is an instantaneous counter; observe its value over several intervals. For an average over time, use PhysicalDisk\Avg. Disk Queue Length.
Memory
Memory\ Available Bytes
Less than 4 MB
Research memory usage and add memory if needed.
Memory
Memory\ Pages/sec
20
Research paging activity. 
Network
Network Segment\% Net Utilization
Depends on type of network
You must determine the threshold based on the type of network you are running. For Ethernet networks, for example, 30 percent is the recommended threshold.
Paging File
Paging File\% Usage
Above 70 percent
Review this value in conjunction with Available Bytes and Pages/sec to understand paging activity on your computer.
Processor
Processor\% Processor Time
85 percent
Find the process that is using a high percentage of processor time. Upgrade to a faster processor or install an additional processor.
Processor
Processor\ Interrupts/sec
Depends on processor; for current CPUs, use a threshold of 1500 interrupts per second.
A dramatic increase in this counter value without a corresponding increase in system activity indicates a hardware problem. Identify the network adapter or disk controller card causing the interrupts. You might need to install an additional adapter or controller card.
Server
Server\Bytes Total/sec

If the sum of Bytes Total/sec for all servers is roughly equal to the maximum transfer rates of your network, you might need to segment the network.
Server
Server\Work Item Shortages
3
If the value reaches this threshold, consider tuning the InitWorkItems or MaxWorkItems entries in the registry (in HKEY_LOCAL_MACHINE
\SYSTEM\CurrentControlSet
\Services\lanmanserver\Parameters). For more information about MaxWorkItems, see the Microsoft Knowledge Base link on the Web Resources page at http://windows.microsoft.com/windows2000/reskit/webresourcesCaution   Do not use a registry editor to edit the registry directly unless you have no alternative. The registry editors bypass the standard safeguards provided by administrative tools. These safeguards prevent you from entering conflicting settings or settings that are likely to degrade performance or damage your system. Editing the registry directly can have serious, unexpected consequences that can prevent the system from starting and require that you reinstall Windows 2000. To configure or customize Windows 2000, use the programs in Control Panel or Microsoft Management Console whenever possible.
Server
Server Work Queues\Queue Length
4
If the value reaches this threshold, there might be a processor bottleneck. This is an instantaneous counter; observe its value over several intervals.
Multiple Processors
System\Processor Queue Length
2
This is an instantaneous counter; observe its value over several intervals.
Investigating Bottlenecks
Investigating performance problems should always start with monitoring the whole system before looking at individual components. In precise terms, a bottleneck exists if a particular component’s limitation is keeping the entire system from performing more quickly. Therefore, even if one or more components in your system is heavily used, if other components or the system as a whole show no adverse effects, then there is no bottleneck.
For example, suppose that a process had 10 threads, each of which used exactly 0.999 seconds of processor time once every 10 seconds. If each thread made a request exactly 1 second after the previous one in perfect sequence, the processor would be 99.9 percent busy, but there would be no queue, no interference between the threads, and, technically, no bottleneck, although the system probably could not support any increased load or variation in its request scheduling without creating one.
Factors involved in the development of a bottleneck are the number of requests for service, the frequency with which requests occur, and the duration of each request. As long as these are perfectly synchronized, no queue will develop and no bottleneck will arise. The device with the smallest throughput ratio is probably the primary source of the bottleneck.
It is difficult to detect multiple bottlenecks in a system. You might spend several days testing and retesting to identify and eliminate a bottleneck, only to find that another appears in its place. Only thorough and patient testing of all elements can ensure that you have found all of the problems.
It is not unusual to trace a performance problem to multiple sources. Poor response time on a workstation is most likely to result from memory and processor problems. Servers are more susceptible to disk and network problems.
Also, problems in one component might be the result of problems in another component, not the cause. For example, when memory is scarce, the system begins moving pages of code and data between disks and physical memory. The memory shortage becomes evident from increased disk and processor use, but the problem is memory, not the processor or disk.
If you identify a resource that is out of range for your baseline or based on the recommended thresholds discussed in the preceding section, you need to investigate the activity of that resource in greater detail. This includes the following steps:

Analyze your hardware and software configurations. Does your configuration match Microsoft recommendations for the operating system and the services you are supporting?

Review entries in the event log for the time period when you begin seeing out-of-range counter values; these entries might provide information on problems that might result in poor system performance.

Examine the kinds of applications you are running and what resources they demand, to determine their adequacy.

Consider variables in your workload, such as processing different jobs at different times. For more efficient analysis, when you are looking for a specific problem, limit your charts and reports to specific events occurring at known times.

For immediate diagnosis and problem solving of situations such as shutdowns and logon failures, log or monitor for a shorter time. Sampling should be frequent when monitoring over a short period. Similarly, for long-term planning and analysis, log for a longer period and set the update interval accordingly.

Consider network or disk utilization or other activities occurring at the times that you see increasing resource utilization. Try to understand the usage patterns. Are they associated with specific protocols or computers?

Approach bottleneck correction in a scientific manner. For example, never make more than one change at a time, always repeat monitoring after a change to validate the results, eliminate results that are suspect, and keep good records of what you have done and what you have learned.
When investigating bottlenecks in specific resources, focus on the performance objects and counters that pertain to the specific resource that appears to be your bottleneck. Your reference for information about these counters and how to detect and correct bottlenecks should be the chapter of this guide that refers to the resource you are investigating. These chapters also discuss how to use other Windows 2000 tools and utilities on the Windows 2000 Resource Kit companion CD for bottleneck detection and tuning. The chapters are as follows:

“Evaluating Memory and Cache Usage”

“Analyzing Processor Activity”

“Examining and Tuning Disk Performance” 

“Monitoring Network Performance”

“Measuring Multiprocessor System Activity”
Troubleshooting Problems with Performance Tools
Occasionally you might have problems obtaining performance data, or you might find that monitoring a process is adding an unnecessary load to a computer you are monitoring. The following sections discuss how to handle some of these problems:

Investigating Zero Values

Investigating Other Problems with Tool Usage

Controlling Performance Monitoring Overhead
Investigating Zero Values
If data for selected counters is consistently reported as zeroes, this might indicate a problem with the counters or the way you are using the performance tools, rather than just the absence of any nonzero data. Following are descriptions of the possible causes and solutions to problems that result in missing or zero counter values.

The process being monitored has stopped and, as a result, there is no data for the process in the performance tools. If you stopped the process manually, restart it to see the process in System Monitor. Otherwise, check Event Viewer for concurrent entries. You might find an error associated with this process.

The counter DLL was disabled after you selected the corresponding counters in a log or display. The performance tools will not detect that the counter was removed or disabled, but will report the counter data as zeroes.

You are attempting to monitor a computer that you don’t have permission to access. This might occur if you are using a saved console that specifies a particular computer name. This causes System Monitor to report data as zeroes. It also causes System Monitor to start up slowly. For more information see “Security Issues” later in this chapter.
Investigating Other Issues with Performance Tools
You might occasionally believe that data reported by the performance tools is invalid, that data is incomplete, or that the tools are not operating properly. This section addresses some problems you might encounter with the tools and how to correct them.
Data seems to be missing.

System Monitor might show gaps in its line graphs because data collection was subordinated to higher-priority processing activity on a system with a heavy load. When the system has adequate resources to continue with data collection, the graphing will resume as usual. A message appears describing this. Note also that you might see delays in display of data for some counters. Counters that display an average must wait for two samples to elapse before displaying a value. For ways to reduce the performance overhead of system monitoring, see “Controlling Performance Monitoring Overhead” later in this chapter.

Values recorded in a log do not appear in the graph view. This is because the graph is limited to 100 samples. Reducing the size of the Time Window on the Data property tab can allow you to see a more complete range of data.
Objects, counters, or instances seem to be missing or invalid.
In some cases you might find that you cannot find an object you want to monitor. This might be caused by the following:

You have not started or installed the process that starts the object counters. Use Task Manager to verify that the process is running. If so, use Exctrlst.exe on the Windows 2000 Resource Kit companion CD to verify that the counter DLL is running.

You have not enabled the counters (such as with the Network Segment object counters). If you do not see a counter that you want to monitor, make sure that the service or feature that provides the counter has been installed or configured. For information about how to install or configure the service or feature, see online Help for the service or feature.

If counters have been disabled, then they will not appear in the Add Counters dialog box. There are several reasons that a counter DLL might be disabled:

A user disables counter DLLs using Exctrlst.exe on the Windows 2000 Resource Kit companion CD.

The Performance Library’s built-in testing routines have found problems with the counter DLLs and have disabled them to prevent them from interfering with operation of the Performance console. If this has occurred, the Application Log in Event Viewer contains a message to this effect.

To re-enable the counters for debugging purposes, locate the Performance subkey under the subkey for the service (typically, HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\service_name\Performance\) and change the value for the Disable Performance Counters entry from 1 (disabled) to 0 (enabled). Notice that a counter DLL that the system has automatically disabled is likely to contain errors and may cause the system to slow. 

You lack permissions on the computer being monitored. If you do not have appropriate permissions to monitor the computer, an error message will be displayed when you attempt to select the computer. An administrator must ensure that your user account has permissions to use the performance tools. If you are trying to monitor a remote system, for information about security issues, see “Monitoring Remote Computers” later in this chapter.

The DLL that installs the counters is generating errors. An example is if the counter does not handle localization functions correctly. Check Event Viewer to see if the counter DLL or the Performance Data Helper (PDH) library reported any errors. If necessary, you can disable counter DLLs that are causing errors by using Exctrlst.exe on the Windows 2000 Resource Kit companion CD.

You are trying to monitor a 16-bit or MS-DOS application. Only 32-bit processes appear in the Instances box. Active 16-bit processes appear as threads running in a Windows NT Virtual DOS Machine (NTVDM) process. (Virtual DOS Machine is an environment system for MS-DOS and 16-bit Windows emulation.) If you want to monitor a 16-bit application, see “Monitoring 16-bit Windows Applications” later in this chapter.

Note   When trying to monitor administrative tools hosted in MMC, note that they appear as instances of MMC in the Add Counters dialog box.

The instance you want to monitor is not currently active. If you are configuring System Monitor to collect real-time data, you can only select active instances for data collection. (If you are viewing logged data, you can select inactive instances for which the log contains data.) If you select the process and it stops after you have selected it, it will continue to appear in the list box but the reported data will be zeroes.

You might see situations where an instance seems inappropriate for the counter—such as the _Total instance for the Process\ID Process counter. All counters for an object have the same instances.
Data seems invalid.
There are several reasons that counters might report unlikely values:

You sometimes see an extremely high value for one instance and not the other when you are monitoring processes of the same name. This is because the performance tools sometimes misrepresent data for separate instances of processes with the same name by reporting the combined values of the instances as the value of a single instance. Using the instance index and tracking the Process\ID Process and Process\Creating Process ID counters can help you get around this problem.

Also, when monitoring several threads and one of them stops, the data for one thread might appear to be reported for another. This is because of the way threads are numbered. For example, you begin monitoring and have three threads, numbered 0, 1, and 2. If one of them stops, all remaining threads are resequenced. That means that the original thread 0 is now gone and the original thread 1 is renamed to 0. As a result, data for the stopped thread 0 could be reported along with data for the running thread 1 because old thread 1 is now old thread 0. Again, using the instance index can help you to track these threads.
Problems with System Monitor and MMC

If you are trying to create a custom console with System Monitor and another tool, you might have a problem because System Monitor is not listed in the Add Standalone Snap-in dialog box. This is because System Monitor is not designed as an extension snap-in but as an ActiveX control. To create a custom console containing System Monitor, you select ActiveX Control in the Add Standalone Snap-in dialog box and select System Monitor Control in the Insert ActiveX Control dialog box. System Monitor Control will appear as the name of the utility in your custom console; you can change it as needed.

Help for System Monitor does not appear in MMC; only Performance Logs and Alerts is shown in MMC Help. Because System Monitor is designed as an ActiveX control, it is unlike other MMC snap-ins. For example, System Monitor Help is not available by clicking Help Topics on the Help menu or by right-clicking System Monitor and selecting Help in the shortcut menu. Instead, click Help on the System Monitor display toolbar.
Problems with logs

Trace log data is not output as readable text. You must use a parsing utility to interpret the trace log output. Developers can create such a utility with the APIs provided in the Platform Software Development Kit.

An error message appears if you try to export log data to Microsoft Excel while the Performance Logs and Alerts service is actively collecting data to that log. The service must be stopped because Excel requires exclusive access to the log file. Other programs are not known to require this exclusive access; therefore, in general, you can work with data from a log file while the service is collecting data to that file.

Data from a running log does not seem to be updating. If you are working in System Monitor with a log file that is currently collecting data, you will need to click Select Time Range and keep moving the Time Range bar to the right to update the display with new samples.

Processes that started while a log was running do not appear in my exported log. Logged data can be saved as comma-separated or tab-separated files that are easily viewed with Microsoft Excel. However, some limitations apply when you use this format. Instances that start after the log is started will not be reflected. You need to use the binary log format to see data for these instances.

Errors occur regarding counter log size. This could be because your counter log has consumed the available space on the hard drive that you specified in the log file path. In addition, counter logs have a maximum size of 2 GB, and a message will appear when the log reaches this limit. Note that logs this size are unwieldy and slow to work with.

An exported monitoring configuration is collecting data from the wrong computer. This is probably because you selected the Select counters from computer option when you saved the console and installed it on another system. Instead, select Use local computer counters.

The Performance Logs and Alerts service stops and does not restart. If a network connection is lost during remote monitoring, or if there is a problem with a counter DLL, this could cause the Performance Logs and Alerts service to shut down. The service is configured to restart only once after the first failure. Thereafter, you need to start the service manually. To avoid recurrence of this problem, modify the startup properties of the services in Services under Administrative Tools. Also make sure to investigate the cause of the shutdown by reviewing the event log and disabling problem DLLs. To do this, use Exctrlst, a utility included on the Windows 2000 Resource Kit companion CD.

Workspace (.pmw) files that were created with Windows NT 4.0 Performance Monitor are not fully compatible with Windows 2000 System Monitor. Only one of the views saved in the workspace is available in System Monitor. System Monitor can read log files created with earlier versions of Performance Monitor when you use the following syntax at the Windows 2000 command prompt:
perfmon.exe log_file_name
This command does not invoke Windows NT 4.0 Performance Monitor, but instead a shell program that starts System Monitor. Windows NT 4.0 Performance Monitor is available as Perfmon4.exe on the Windows 2000 Resource Kit companion CD.
Controlling Performance Monitoring Overhead
When you select a counter in any view, the performance tools collect data for all counters of that object, but display only the one you select. This causes only minimal overhead, because most of the tools’ overhead results from the display. You can control monitoring overhead in the following ways:

Use logs instead of displaying a graph. The user interface is more costly in terms of performance.

Limit the use of costly counters; this increases monitoring overhead. For information about costly counters, see the Performance Counter Reference on the Microsoft® Windows® 2000 Resource Kit companion CD.

Lengthen collection intervals if possible. In general, 600-second (10-minute) intervals are sufficient for ordinary monitoring.

Collect data during peak activity rather than over an extended interval.

Reduce the number of objects monitored unless these are critical to your analysis.

Put the log file on a disk that you are not monitoring.

Check the log file size when logging multiple servers to a single computer to see how much space the data is taking up.

Limit to brief periods the trace logs that are monitoring page faults or file I/O. Prolonged trace logging strains system performance.

Avoid configuring System Monitor reports to display nondefault data. If you choose nondefault data (the defaults are Average value for logs; Last value for graphs) in the Report view, the statistic is calculated at each sample interval. This incurs some additional performance overhead.
Specific Monitoring Scenarios
This section describes various scenarios such as monitoring remote computers and monitoring servers and services.
Monitoring Remote Computers
In general, monitoring remote computers differs little from monitoring local computers. This section discusses some facts to consider when evaluating whether to monitor remotely or locally.
Methods of Monitoring
When monitoring activity on remote computers, you have some options with regard to how to collect data. For example, you could run a counter log on the administrator’s computer, drawing data continuously from each remote computer. In another case, you could have each computer that is running the service collect data and, at regular intervals, run a batch program to transfer the data to the administrator’s computer for analysis and archiving. Figure 5.12 illustrates these options.
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Figure 5.12   Comparison of Performance Data Logging Options
Choose a monitoring method based on your needs from the ones described in the following list:

Centralized data collection (that is, collection on a local computer from remote computers that you are monitoring) is simple to implement because only one logging service is running. You can collect data from multiple systems into a single log file. However, it causes additional network traffic and might be constrained by available memory on the administrator’s computer. Frequent updating also adds to network activity. Centralized monitoring is useful for a small number of servers (25 or fewer). For centralized monitoring, use the Add Counters dialog box to select a remote computer while running System Monitor on your local computer.

Distributed data collection (that is, data collection that occurs on the remote computers you are monitoring) does not incur the memory and network traffic problems of local collection. However, it does result in delayed availability of the data, requiring that the collected data be transferred to the administrator’s computer for review. This kind of monitoring might be useful if you suspect the server is part of the problem. It is also useful if you suspect that the network is the cause of performance problems and you are concerned that data packets you want to monitor are being lost, because it isolates the computers from the network during data collection. In general, local monitoring creates more disk traffic on each monitored computer. For distributed monitoring, use Performance Logs and Alerts under Computer Management to select the computer you want to monitor.
Security Issues
If you are collecting data using the registry, monitoring a remote computer requires the use of the Remote Registry Service. If the service stops due to failure, the system restarts it automatically only once. Therefore, if the service stops more than once, you must restart the service manually on the second and any subsequent failures. To change this default behavior, modify the properties for Remote Registry Service. You can access service properties using Services under Services and Applications in Computer Management or under Administrative Tools. Also check the application and system logs in Event Viewer for events that might explain why the service stopped.
In addition, remote data collection requires access to certain registry subkeys and system files. Users need a minimum of Read access to the Winreg subkey in HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurePipeServers to provide remote access to the registry for the purpose of collecting data on remote systems. By default, members of the Administrators group have Full Control access and members of the Backup Operators group have Read access. Users also need Read access to the registry subkey that stores counter names and descriptions used by System Monitor. This subkey is HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib\LanguageID, where LanguageID is the numeric code for the spoken language for the operating system installation. (For the English language, the subkey is Perflib\009.) By default, members of the Administrators and Creator Owners groups, and the System account, have Full Control access and members of the Interactive group have Read access.
Users might also require read access to the files that supply counter names and descriptions to the registry, Perfc*.dat and Perfh*.dat. (The asterisk is a wildcard character representing the specific language code; for English, these are Perfc009.dat and Perfh009.dat.) If these files reside on an NTFS volume, then, in order to have access to them, the access control lists (ACLs) on these files must specify that the user has such access. By default, members of the Administrators and Interactive groups have sufficient access.
The remote computer allows access only to user accounts that have permission to access it. In order to monitor remote computers, the Performance Logs and Alerts service must be started in an account that has permission to access the remote computers you are attempting to monitor. By default, the service is started under the local computer’s system account, which generally has permission to access only services and resources on the local computer. To start this under a different account, start Computer Management, click the plus sign (+) beside Services and Applications, and click Services. Click Performance Logs and Alerts, and update the properties under the Log On tab. To monitor using counter logs or alerts, you must also have permission to read the HKEY_CURRENT_MACHINE\SYSTEM\CurrentControlSet\Services\SysmonLog\LogQueries registry subkey.) In general, administrators have this access by default. In each case, attempting to use the tools without appropriate permissions will generate an error message.
If you are collecting data remotely by means of WMI, the user must be a member of the Administrators group.
Monitoring Servers and Services
Computers that provide shared resources to users of a network are called servers. This section describes the relationship between a the workload of a server and its resource utilization. This section also covers establishing a baseline for a server, identifying emerging problems, and upgrading.
Characterizing Server Workload
Some servers are characterized by the workload they support, as indicated in Table 5.9. Servers supporting these workloads can have specific resource requirements. These requirements and how to monitor them with performance monitoring tools are described later in this chapter.
Table 5.9   Objects to Monitor Based on Server Workload
Server workload
Heaviest resource usage
Objects to monitor
Application servers
Memory and processor
Cache, Memory, Processor, and System
Servers used for backups
Processor and network
System, Server, Processor, and Network Segment
Database servers
Disks and processor
PhysicalDisk, LogicalDisk, Processor, and SystemIf using Microsoft® SQL Server™, see the product documentation for information about installed performance objects.
Domain controllers
Memory, processor, network, and disk
Memory, Processor, System, Network Segment, Network Interface, protocol counters (TCP, UDP, ICMP, IP, NBT Connection, NetBEUI, NetBEUI Resource, NWLink IPX, NWLink NetBIOS, NWLink SPX), PhysicalDisk, and LogicalDiskThe NWLink object counters report zero values for frame-related data.For Active Directory, also monitor the NTDS and Site Server LDAP Service objects; for Windows 2000 servers, monitor the Browser object. As applicable, monitor DNS or WINS objects.
File and print servers
Memory, disk, and network components
Memory, Network Segment, PhysicalDisk, and LogicalDiskFor print servers, use the Print Queue object for monitoring queue activity.
Mail/messaging servers
Processor, disk, and memory
Memory, Cache, Processor, System, PhysicalDisk, and LogicalDiskIf using Microsoft Exchange, see the product documentation for information about installed performance objects.
Web servers
Disk, cache, and network components
Cache, Network Segment, PhysicalDisk, and LogicalDisk
Tip   As a general recommendation, servers with major roles should be dedicated to a single purpose rather than shared among multiple purposes. For example, do not have domain servers or database servers do double duty as application or file and print servers because these secondary activities can impede the ability of the server to handle its primary workload.
As a service runs, it makes specific demands on system resources. In addition to the monitoring resource requirements defined by the computer’s workload, you can obtain information about the services using performance data made available through the services. Many services running under Windows 2000 Server supply performance counters that can be used to measure service activity and resource utilization. Monitoring these counters provides data you can use to determine how well your server is functioning.
In addition to the standard counters described in “Overview of Performance Monitoring,” you can use the System object counters to obtain information of interest on server computers. For example, you might want to examine the values for System\System Up Time. If this value is consistently low, it might indicate frequent failures, meaning that the server remains up only for a short time.
Establishing a Baseline on Server Computers
Monitor the performance of your server at the busiest times of day as well as when it is idle or when activity levels are low. Consider the number of concurrent users as well as the number of inactive connections during the times you are monitoring because the server expends resources tracking inactive as well as active connections. After collecting and reviewing this data, you can set a baseline for the performance of your server. This baseline can be used as a reference point for determining when performance problems exist and for projecting future resource requirements. When data consistently falls outside of the baseline ranges, consider it a signal that the performance of your server is changing—either because the demand is increasing or a bottleneck is developing. You will then want to monitor activity more closely to determine whether your server needs tuning or upgrading.
When you become aware of changes in performance that result in values outside your baseline, monitor the system counters representing the disk, memory, processor, and network components along with the Processor\% Processor Time counter for the services that you are running to see if there is a correlation between service activity and resource usage. If so, you might need to tune the service.
Note   Unless you are testing a computer’s startup performance, wait until the startup process has concluded before monitoring system performance. Otherwise, you might mistake the high utilization values characteristic of process startup for the process’s typical load.
In general, you will want to monitor a server from a different computer so as to minimize the impact of the testing process on the computer being tested. For more information about the advantages and disadvantages of remote versus local monitoring, see “Monitoring Remote Computers” earlier in this chapter.
Upgrading Servers and Capacity Planning
The chapters “Analyzing Processor Activity,” “Evaluating Memory and Cache Usage,” and “Examining and Tuning Disk Performance” in this book provide information about tuning and planning for upgrades for hardware resources such as memory, processors, or disks when counter values indicate that these are being strained by your workload. In addition, the chapter “Measuring Multiprocessor System Activity” addresses the special considerations for obtaining optimal performance from scaled systems and discusses the benefits of server clustering and load balancing.
The capacity of a server depends on many variables, including the number of work units (such as client requests), the amount of time required for each unit, and the corresponding resource utilization. Because of the many variables of an individual server implementation, it is extremely difficult to arrive at a perfect formula for gauging the capacity of your server.
Monitoring Legacy Applications
For optimal performance, it is recommended that all applications you run under Windows 2000 be 32-bit. However, if you need to continue using 16-bit Windows or MS-DOS-based applications, this section describes how you can monitor their activity.
Monitoring 16-bit Windows Applications
In Windows 2000, by default, all active 16-bit Windows applications run as separate threads in a single multithreaded process called NT Virtual DOS Machine (NTVDM). The NTVDM process simulates a 16-bit Windows environment complete with all of the DLLs called by 16-bit Windows applications.
This configuration poses two challenges for running 16-bit applications:

It prevents 16-bit applications from running simultaneously, which might impede their performance.

It makes monitoring a bit trickier because 16-bit applications do not appear by name in the Add Counters dialog box for the performance tools; instead, they appear as undistinguishable NTVDM processes.
As a result, Windows 2000 includes an option to run a 16-bit application in its own separate NTVDM process with its own address space. You can monitor 16-bit Windows applications by identifying them by their thread identifier (ID) while they are running, or by running each application in a separate address space.
In addition to the 16-bit applications, each NTVDM process includes a heartbeat thread that interrupts every 55 milliseconds to simulate a timer interrupt, and the Wowexec.exe thread, which helps to create 16-bit tasks and to handle the delivery of the 16-bit interrupt. This thread supports 16-bit Windows applications in a 32-bit Windows environment. The WOW subsystem provides a virtual DOS machine where all Win16 applications run. You will see the heartbeat and Wowexec threads when monitoring 16-bit applications.
Only one 16-bit Windows application thread in an NTVDM can run at one time and, if an application thread is preempted, the NTVDM always resumes with the same thread. This limits the performance of multiple 16-bit applications running in the same NTVDM process, although this limitation becomes an issue only when the processor is very busy.
Although System Monitor can monitor 16-bit applications in Windows 2000 because they run in the same process, the trick to monitoring more than one 16-bit application is to distinguish among the threads of the NTVDM process.
To monitor one 16-bit application, select the NTVDM process in System Monitor. (Other performance tools used to monitor processes can be used for monitoring the NTVDM process. For more information, see “Analyzing Processor Activity” in this book.) If you have multiple 16-bit processes running in NTVDM, you can distinguish them by their thread identifiers (IDs). You might have to start and stop the 16-bit process to determine which ID is associated with which 16-bit process.
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Figure 5.13   NTVDM Threads in System Monitor
Figure 5.13 shows a System Monitor report on a single NTVDM process. The ID Process and ID Thread counters are included to help you distinguish among the threads. One of the threads is the heartbeat thread, one is the Wowexec thread, and one is a 16-bit application.
System Monitor identifies threads by the process name and a thread number. The thread numbers are ordinal numbers (beginning with 0) that represent the order in which the threads started. The thread number of a running thread changes when a thread with a lower number stops, and all threads with higher numbers move up in order to close the gap. For example, if thread 1 stopped, thread 2 becomes thread 1. Therefore, thread numbers are not reliable indicators of thread identity.
Instead, with System Monitor you can track processes and threads using the process IDs and thread IDs. The process ID identifies the process in which the thread runs. The thread ID identifies the thread. Unlike the thread number, which can change over the time the thread runs, the system assigns the thread ID when the thread starts and retains it until the thread stops.
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Figure 5.14   MyApp, Wowexec, and Ntvdm on the Task Manager Process Tab
As shown in Figure 5.14, Task Manager makes it easy to identify 16-bit applications because it displays the names of the executable files indented below the NTVDM process name. To monitor 16-bit processes in Task Manager, click the Processes tab, and on the Options menu, click Show 16-bit Tasks.
In this example, you can see the Wowexec (Windows on Windows) and the MyApp threads. The heartbeat thread is not an executable and does not appear as a process in Task Manager. However, the Thread Count column on the far right shows that all threads are running in the NTVDM process.
Running 16-bit Windows Applications in a Separate Process
Windows 2000 lets you opt to run a 16-bit Windows application in separate, unshared NTVDM process with its own memory space. This eliminates competition between NTVDM threads in a single process, making the 16-bit application thread fully multitasking and preemptive. It also simplifies monitoring.
To run a 16-bit application in its own address space

At the command prompt, type:

start  /separate processname
In Task Manager and System Monitor, two instances of the NTVDM process appear. You can use their process identifiers to distinguish between them. Figure 5.15 shows NTVDM threads with the process identifier.
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Figure 5.15   NTVDM Instances in Task Manager with Process Identifiers
Figure 5.15 shows Task Manager monitoring two copies of a 16-bit application, each in its own NTVDM process.
Monitoring MS-DOS Applications
In Windows 2000, each MS-DOS application runs in its own NTVDM process, eliminating some of the problems encountered in 16-bit Windows applications. All of the NTVDM processes are called Ntvdm.exe by default, but you can use the following procedure to change the name for easier tracking.
To create a new process name for an NTVDM process
 1.
Copy Ntvdm.exe to a file with a different name.
 2.
Change the value of the cmdline entry in HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\WOW to the name of your copy of Ntvdm.exe. The default value is systemroot\System32\Ntvdm.exe.
 3.
When you start an MS-DOS application, it will run in a process with that name. Figure 5.16 shows how your edited process name appears in Regedt32.
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Figure 5.16   New Process Name in Regedt32
Tip   You do not have to restart the computer for the registry change to take effect. Thus, you can change the registry between starting different MS-DOS applications and have each start in a uniquely named process. It is also prudent to set the process name back to Ntvdm.exe when you are finished.
If you are not satisfied with the performance of your MS-DOS-based applications in Windows 2000, try changing the following settings, accessed by right-clicking the file in Windows Explorer:

Under Usage in Screen properties for the .pif file, select Full-Screen to speed up video display performance. Press ALT+ENTER to get in and out of full-screen mode.

Disable the Compatible Timer Hardware Emulation feature in the _Default.pif or the application’s program information file (PIF). To disable it, clear the check box displayed when you click the Windows NT button under Program properties for the file. Because this feature causes a decrease in performance, use it only if it is required to allow an application to run under Windows 2000.

If the application is in a window and seems to pause periodically, try reducing idle sensitivity by moving the Idle Sensitivity slider to the left in Misc properties for the application’s .pif.

If the MS-DOS-based application can be configured for printing, choose LPT1 or LPT2 rather than parallel port. Most of the applications use Int17 to print when configured for LPT. If you select parallel port mode, these applications print directly to printer ports. Parallel mode is significantly slower in Windows 2000 compared to Windows 3.x.
Integrating the System Monitor Control into Office and Other Applications
You can host the System Monitor ActiveX control in applications of the Microsoft Office 97 suite or later and in HTML pages. The following sections describe how to integrate and use these controls, including the following:

Inserting the control into an Office document or on a Web page

Formatting the control within a document
Placing the Control in an Office Document or on a Web Page
Integration of the Microsoft Office applications with Visual Basic for Applications makes the process of adding the System Monitor control almost identical across these applications. The following procedures describe how to insert the control in applications such as Microsoft Word, Microsoft Excel, and Microsoft PowerPoint®. For purposes of this section, the word “document” is used to refer to PowerPoint slides, Word documents, or Excel spreadsheets.

Default key settings in Microsoft Word might conflict with the CTRL+H combination used for System Monitor highlighting. You might need to change these to support highlighting when the System Monitor control (Sysmon.ocx in the systemroot\System32 folder) is used in Microsoft Word.
In addition, you can add the control to a Web page using an HTML editor that supports insertion of ActiveX controls or using a text editor as described in “To insert the control in an HTML Page.”
To insert the System Monitor control into a Microsoft Office application
 1.
Start the application and select Toolbars under the View menu.
 2.
Under Toolbars, select Control Toolbox.
 3.
With the Control Toolbox displayed, click the More Controls icon and select the System Monitor Control.
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Figure 5.17   System Monitor Control in the Control Toolbox

Figure 5.17 shows the System Monitor control selected in the Control Toolbox.
 4.
Place the control on the page according to the requirements of the application. See the following differences among applications:

In a Microsoft Word document, select the insertion point (where the I-beam is flashing) before selecting the control. The control will appear at the position you selected. Design mode is active and you need to exit Design mode before setting control properties or adding counters. Click the Design Mode icon to exit.

In a Microsoft Excel spreadsheet, select the control and then select the insertion point. When the crosshair appears, note that you can create a placeholder for the control by holding down the left mouse button and dragging the mouse pointer across the columns and rows that you want the control to occupy. Releasing the mouse button causes the control to appear in the space you selected.

If you do not create a placeholder, you can click any location on the spreadsheet and the control will be inserted in the location with a default size. Design mode is active and you need to exit Design mode before setting control properties or adding counters. Click the Design Mode icon to exit.

In a Microsoft PowerPoint slide, select the control and then select the insertion point. With the crosshair visible on the screen, note that you can hold down and drag the mouse button to the size you want and the control will be inserted in the placeholder. Otherwise, you can click anywhere on the slide to place the control in that location with a default size and you can modify the size coordinates later (as described in “To format the control in a document”).

The Design mode icon is not displayed after you insert the control although Design mode is in effect. To exit Design mode, on the View menu, click Slide Show.
Note   The System Monitor control is not displayed correctly until you exit Design mode.
With the control sited in the document, you can add counters or modify control properties, as described in the System Monitor Help file (Sysmon.chm).
If you select Graph for the Display Type and the size you define for the control is insufficient to show the graph data, only a portion of the graph will be displayed (such as the vertical minimum and maximum scale values, and the counter-data graph lines).
If you select Report for the Display Type and the size is insufficient to show all the report data, the control includes vertical and horizontal scroll bars so that you can scroll to view the data that does not fit in the display.
If you want to format the control in the application, resume Design mode by clicking  the Design mode icon in the Control Toolbox and see the procedure named “To format the control in a document” later in this chapter.
To insert the control in a Microsoft Visual Basic program
 1.
On the File menu, choose New to open a new project (such as a Standard EXE or an ActiveX Document EXE). 
 2.
On the Project menu, click Components to show the Components dialog box.

You can also view the Components dialog box by right-clicking the Toolbox. If the Toolbox is not displayed, in the View menu, select the Toolbox command.
 3.
Under Controls in the Components dialog box, select the System Monitor Control Library check box, and then click OK.

An icon for the System Monitor control now appears in the Toolbox.
 4.
With the form or the document displayed, double-click the System Monitor Control icon to add it to the form or document for your program.

This places the control in the document, occupying the entire size of the form. If you want to select a size for the control, click the System Monitor Control icon once and then, when the crosshair appears, hold down and drag the mouse to the size you want the control to occupy on the form.
Immediately after inserting the control, the application is in Design mode, so you can format the control within a document. For more information, see the procedure “To format the control in a document” later in this chapter.
To insert the control in an HTML page

Using a text editor, create a page to include the control. To place the control on the page, insert the <OBJECT> tag and specify the class ID as follows:
<OBJECT classid="clsid:C4D2D8E0-D1DD-11CE-940F-008029004347">
</OBJECT>

This places the control in the document and, when you view the page in a Web browser, you can add counters or modify control properties as described in the procedures that appear later in this document.

To include functions in your page that automate the setting of properties or addition of counters, use scripts written in Visual Basic Scripting Edition (VBScript), or use Microsoft FrontPage®, as described in the following procedure. 
To insert the System Monitor control into a Web page created with Microsoft FrontPage
 1.
In a new or existing FrontPage Web page, on the Insert menu, select Other Components, and then select ActiveX Control.
 2.
In the ActiveX Control Properties dialog box, select Sysmon Graph Control in the Pick A Control list box.
 3.
To add VBScript, click Extended, and complete the Extended Attributes dialog box as needed.

For more information about VBScript, see the VBScript link on the Web Resources page at http://windows.microsoft.com/windows2000/reskit/webresources.
Formatting the Control in a Document
The default appearance of the control can vary based on the document in which it resides. This is because the control takes the ambient properties of the document in which it is running. For example, when placed in Microsoft Word or FrontPage, the graph background, font, and chart background color might be reset to the default color and font used by those documents. Therefore, after you insert the control in a Microsoft Office application, you might want to change its appearance with respect to the document itself.
Using Design mode in Visual Basic or Office documents, you can easily manipulate the control’s attributes such as size, position, and so on as you could with any linked or embedded object. In addition, you have access to the control’s properties, methods, and events from the Visual Basic editor for programming the control’s behavior within the document. (The control’s user interface is inactive when the document is in Design mode.) Note that there are slight differences in how some of the Office applications handle formatting the inserted control.
Note   When changing the properties of the control, it is possible to set colors for BackColor, ForeColor, or GraphBackground, or to set graph line colors that are not visible. Therefore, make sure to check the appearance of your control display after you make changes to its properties.
In addition, you cannot programmatically format the properties and methods of the control using the Visual Basic editor. Use VBScript or Jscript® in your HTML editor for this purpose.
To format the control in a document
 1.
Resume Design mode and make the changes you want. To resume Design mode in PowerPoint, exit the Slide Show view.

To change the position of the control in the document, drag the control to another position in the container.

To change the height or width of the control in the document, drag one of the selection handles of the control in the appropriate direction.
 2.
To access the control properties or the Visual Basic code editor, right-click the control and select Properties or View Code, as appropriate. In the Visual Basic code editor window, you can view the Object Browser if needed.

Notice that some commands on this shortcut menu (such as Cut, Copy, or Paste) are designed for other embedded or linked objects in that document; they are not relevant to the control and might be unavailable (dimmed).

Note   When you use Microsoft Office applications, it is possible to modify the control in the document so that the control’s properties become inaccessible. This occurs because the control is being converted into an embedded object. For example, if you click the System Monitor Control Object command in Microsoft Word (by right-clicking the control) and select the Convert command, the Convert dialog box appears. If you click OK in this box, the control’s properties and view-code option become unavailable. You will not be able to change the position or the size of the object in Word.
 3.
Exit Design mode before trying to add counters or to edit the control’s default properties.
Notice that the appearance of the control might not update properly until you exit Design mode.
For information about the control’s objects, properties, and so on, see the Software Development Kit (SDK) documentation in the MSDN Library at http://windows.microsoft.com/windows2000/reskit/webresources.
